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เมื่อท่านหยิบหนังสือเล่มนี้ขึ้นมาอ่านแล้ว ท่านอาจจะพบว่าทำไมเนื้อหา
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ซึ่งไม่เป็นที่น่าแปลกใจเลย เพราะผู้เขียนเองก็เคยเป็นดังเช่นท่าน ตอนที่เรียนอยู่
ในมหาวิทยาลัย การท่ีจะเขียนโปรแกรมเพ่ือนำมาใช้งานเองสักโปรแกรม ทำไมมันช่างแสน
ยากเย็นเช่นน้ี และจะใช้ภาษาอะไรเป็นตัวเขียนโปรแกรมดีล่ะ แต่ท่ีกล่าวมาก็ยังไม่เท่าไร
ปัญหากับอยู่ตรงที่ว่า จะหาหนังสือที่อ่านแล้วทำให้เราทำงานได้ และรู้จริง ไม่เน้น
ด้านทฤษฎี หรืออธิบายแต่ทางหลักวิชาการเพียงอย่างเดียว หนังสือท่ีท่านหยิบอ่านเล่มน้ี
สามารถหลุดพ้นจากพันธนาการที่กล่าวมาข้างต้น เพราะเน้นทุกด้านให้กับทุกท่าน
ทีค่ดิจะเปน็โปรแกรมเมอร ์หรอืเร่ิมตน้การเขยีนโปรแกรมใชง้านเอง โดยจะอธบิายดว้ย
ถ้อยคำ และภาษาทีเ่ข้าใจง่าย โดยในหนงัสือเล่มน้ี ผู้เขียนจะแบ่งเน้ือหาออกเป็น 3 ส่วน
ด้วยกัน ดังน้ี

ส่วนท่ี 1 “เปิดประตู โปรแกรมวชิวลเบสิก” เป็นเร่ืองของทฤษฎ ีซ่ึงอธิบาย
รูปแบบ และวิธีการต่าง ๆ  ท่ีใช้ในโปรแกรมวิชวลเบสิกข้ันพ้ืนฐาน  แบบนำไปใช้ในงานจริง
อย่างไม่มีปัญหา

ส่วนที ่2 “ทำไปลองไป มือใหมหั่ดเขียนโปรแกรม” เป็นการทดลองเขยีน
โปรแกรมทีละขั้นตอน เพื่อนำไปใช้งานจริง ซึ่งเน้นทั้งทฤษฎี และปฏิบัติควบคู่กันไป
ในขณะเขียนโปรแกรม

ส่วนที ่ 3 “กลเมด็เคลด็ลับกับโคด้เด็ด” เป็นการเนน้ทำ WorkShop และ
ศึกษาโค้ดการใช้งาน ให้กับผู้เขียนโปรแกรม เพ่ือนำไปประยุกต์ใช้กับงาน
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‡√‘Ë¡·√°°ËÕπ„™Èß“π‚ª√·°√¡«‘™«≈‡∫ ‘°

ในการพฒันาหรอืเขยีนโปรแกรมขึน้มา โปรแกรมเมอรจ์ะตอ้งมคีวามรู้
ความเข้าใจ ในตัวภาษา ที่จะนำมาใช้ในการพัฒนาเป็นอย่างมาก ไม่ว่าจะ
พฒันาดว้ยภาษาใดกต็าม เช่น ภาษาซ ีปาสกาล เป็นตน้ และจะตอ้งเขยีนโคด้
ที่มีความสัมพันธ์กัน ตั้งแต่บรรทัดแรกจนถึงบรรทัดสุดท้าย อีกทั้งยังต้องออก
แบบรูปร่างหนา้ตาของแอปพลเิคชันให้ตรงกบัความตอ้งการของผูใ้ช้งาน อีกด้วย
ซึ ่งถ้าถูกใจผู ้ใช้ก็ดีไป แต่ถ้าต้องมีอันจำเป็นในการแก้ไข ทุกสิ ่งทุกอย่าง
ที่ได้ทำมาก็ต้องลงมือทำใหม่ทั ้งหมด ทำให้โปรแกรมเมอร์เสียเวลาในการ
พัฒนาแอปพลิเคชันเป็นอย่างยิ่ง

ต่อมาไมโครซอฟต์ได้นำเสนอ รูปแบบในการเขียนแอปพลิเคชัน
ด้วยการออกโปรแกรมวิชวลเบสิก ถึงแม้ว่าเวอร์ชันแรก จะถูกโปรแกรมเมอร์
มองว่าเป็นเวอร์ชันทดลอง แต่ก็ได้สร้างความแปลกใหม่ ในการเขียนโปรแกรม
เป็นอย่างยิ่ง ความยุ่งยากซับซ้อนถูกซ่อนไว้เบื้องหลัง มีแต่ความสะดวกสบาย
ไว้เบื้องหน้า ซึ่งเตรียมไว้ให้โปรแกรมเมอร์ เนื่องจากความคิดของการเขียน
โปรแกรมเปลี่ยนไปอย่างสิ้นเชิง ด้วยความสามารถของตัวภาษาวิชวลเบสิก
เองก็มีมากขึ ้น เพราะความก้าวหน้าของเทคโนโลยีในยุคปัจจุบัน ทำให้
ไมโครซอฟตเ์พิม่เตมิรูปแบบตา่ง ๆ เขา้ไปมากมาย
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จนกระทั่งโปรแกรมวิชวลเบสิกเป็นเครื่องมือในการพัฒนาโปรแกรม
ที่ไร้เทียมทาน เพราะเทคโนโลยีใหม่ล้วนแล้วแต่มาจากไมโครซอฟต์แทบทั้งสิ้น
เช่น ความสามารถในการสรา้งแอปพลเิคชัน DHTML ซ่ึงใช้ปฏิบัติการบนเวบ็เพจ
รวมถึงการผนวกเทคโนโลยี ActiveX เข้ากับตัวคอนโทรล ทำให้สามารถ
เชื่อมโยงเข้ากับเครื่องมือที่สนับสนุนเทคโนโลยีนี้ได้อีกด้วย

โปรแกรมวชิวลเบสกิไดจั้ดเตรยีมเครือ่งมอืตา่ง ๆ ทีเ่รยีกวา่ คอนโทรล
ไว้คอยอำนวยความสะดวกให้แก่โปรแกรมเมอร์มากมาย ซึ่งจะต้องศึกษาและ
ทำความเขา้ใจกบัตัวคอนโทรลใหม้ากทีสุ่ด ตวัคอนโทรลเหลา่นี ้จะอยูเ่บ้ืองหลงั
ที่ทำให้โปรแกรมวิชวลเบสิกประสบผลสำเร็จ เพราะจะช่วยลดขั้นตอนในการ
พัฒนาไปได้มากทีเดียว

การเขียนโปรแกรมด้วยภาษาวิชวลเบสิก จะเป็นไปในลักษณะการนำ
คอนโทรลชนดิตา่ง ๆ  มาวาดเพือ่ออกแบบหนา้ตาแอปพลเิคชนั ท่ีเรียกวา่ กราฟกิ
ยูสเซอร์อินเตอร์เฟส ซึ่งสามารถที่จะออกแบบอินเตอร์เฟสได้อย่างอิสระ ให้ตรง
กับจุดประสงค์และการนำไปใช้งาน แล้วถึงเริ ่มเขียนโค้ด เพื ่อตอบสนอง
การกระทำของผู้ใช้งาน ในวชิวลเบสกิเรยีกวา่ เหตุการณ์ ซ่ึงถอืวา่เปน็หลกัของ
การเขียนโปรแกรมที่เรียกว่าเขียนโปรแกรมเพื่อตอบสนองเหตุการณ์ที่เกิดขึ้น

สิ่งที่นำไปใช้ร่วมกันเพื่อเป็นแอปพลิเคชันหนึ่ง ๆ เช่น แถบเมนูบาร์
ไดอะล็อกบล็อก จะถูกมองเสมือนว่าเป็นวัตถุชิ้นหนึ่ง ที่เรียกว่า อ็อบเจกต ์
ทุกสิ่งทุกอย่างในแอปพลิเคชัน วิชวลเบสิกจะมองเป็นออบเจ็กต์ที ่สามารถ
ควบคุมพฤติกรรมโดยตรงต่ออ็อบเจกต์นั้นได้ด้วยการเขียนโค้ด หรือสามารถ
เปลี่ยนแปลงคุณสมบัติประจำตัวของอ็อบเจกต์นั้นได้โดยตรง ตัวคอนโทรลก็
ถูกมองว่าเป็นอ็อบเจกต์เช่นกัน ในทุก ๆ อ็อบเจกต์ จะมีคุณสมบัติและเมท็อด
ประจำตัวเสมอ ในแต่ละอ็อบเจกต์อาจจะมีคุณสมบัติและเมท็อดที่เหมือน หรือ
ต่างกนักไ็ด ้ขึ้นอยูก่ับชนดิของออ็บเจกตน์ัน้ ๆ
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:: ¸ÕÃÐÈÑ¡ Ốì  ÊØâªµÔ¹Ñ¹·ì :: »ÃÐÂØ·¸  ÍÔ¹áº¹ ::

ในการพัฒนาแอปพลิเคชันด้วยโปรแกรมวิชวลเบสิก การเขียนโค้ด
จะถกูแบง่ออกเปน็สว่น ๆ ทีเ่รียกวา่ โพรซเียอร ์หรอืโปรแกรมยอ่ย แตล่ะ
โพรซีเยอร์ จะประกอบไปด้วยโค้ดที่พิมพ์เข้าไป แล้วทำให้คอนโทรล หรือ
อ็อบเจกต ์ตอบสนองการกระทำของผูใ้ช้งานโดยสมบรูณ์ในตวัมันเอง ซ่ึงเรยีกวา่
การเขยีนโปรแกรมเชงิวัตถ ุ แต่ตัวภาษาวิชวลเบสิกยังไม่ถือว่า เป็นโปรแกรม
เชิงวัตถุอย่างแท้จริง เนื่องจากข้อจำกัดหลาย ๆ อย่างที่โปรแกรมวิชวลเบสิก
ไม่สามารถทำได้เหมือนกับภาษาซีบวกบวก (C++) การเขียนโปรแกรมเชิงวัตถุ
มีข้อดี คือ ตัวโค้ดจะถูกแบ่งออกเป็นส่วน ๆ  ทำให้ง่ายต่อการตรวจสอบ และดักจับ
ข้อผิดพลาด ซึ่งการแก้ไขดังกล่าวนี้ ไม่ได้ไปกระทบกับโค้ดส่วนอื่น ๆ ในตัวเลย
ทำให้โปรแกรมเมอร์สามารถพัฒนาแอปพลิเคชันออกมาได้อย่างสมบูรณ์มากท่ีสุด
โดยที่ไม่ต้องเสียเวลามากมายดังเช่นในอดีต

สิ่งแรกที่จะได้พบเมื่อเข้าสู่โปรแกรมวิชวลเบสิก คือ ไดอะล็อกบล็อก
เพื่อให้เลือกพัฒนาชนิดของแอปพลิเคชัน ซึ่งมีมากมายหลายชนิดด้วยกัน เช่น
DynamicHTML เป็นแอปพลิเคชันที่ใช้ปฏิบัติการบนเว็บเพจ โดยสร้างเว็บเพจ
แบบ DynamicHTMLให้ตรงตามมาตรฐานขององคก์รดบัเบิลยูสาม   ซ่ึงสามารถ
ตรวจสอบไดจ้าก www.w3.org หรอื ชนดิ ActiveX.dll ซ่ึงเปน็โพรเจกตท์ี่ทำงาน
ในลกัษณะ In-Process จัดเกบ็อยู่ในลกัษณะไฟลไ์ลบราร ี(*.dll) เป็นตน้

ในเบื้องต้น แนะนำให้พัฒนาแอปพลิเคชันชนิด Standard.EXE ก่อน
เพราะเป็นแอปพลิเคชันที ่ใช้งานทั ่ว ๆ ไป เมื ่อคอมไพล์โพรเจกต์ จะได้
แอพพลิเคชันที่มีนามสกุล *.exe เมื่อเลือกชนิดของแอปพลิเคชันแล้ว จะเข้าสู่
สภาพแวดล้อมของโปรแกรมวิชวลเบสิก ซึ่งไมโครซอฟต์เรียกว่า Integrated
Development Environment - IDE

 :: ‡√‘Ë¡µÈπ°—∫‚ª√·°√¡«‘™«≈‡∫ ‘°
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รูปท่ี 1-1 แสดงไดอะล็อกบล็อกของแอปพลิเคชัน ที่ให้โปรแกรมเมอร์เลือกพัฒนา

 :: ∑”§«“¡‡¢È“„®°—∫ ¿“æ·«¥≈ÈÕ¡‚ª√·°√¡«‘™«≈‡∫ ‘°

สภาพแวดลอ้มของโปรแกรมวชิวลเบสกิ คอื หนา้ตา่งคณุสมบตัิ กลุม่
ของเมน ูทลูบาร ์หนา้ตา่งชิน้งาน เปน็ตน้ ทีป่ระกอบกนัขึน้มาเปน็สภาพแวดลอ้ม
ของโปรแกรมวิชวลเบสิก

ในแต่ละส่วนของสภาพแวดล้อมของโปรแกรมวิชวลเบสิก จะมีหน้าที่
แตกตา่งกนัไป ซ่ึงในระหวา่งการพฒันาแอปพลเิคชนั จะตอ้งใช้งาน เชน่ เมนบูาร์
จะมีคำสั่งต่าง ๆ ที่ครอบคลุมการทำงานทั้งหมดในการพัฒนา แถบทูลบาร์จะ
ประกอบไปด้วยปุ่มต่าง ๆ ที่แทนคำสั่งในเมนูที่ใช้งานบ่อย ๆ เช่น การเปิดปิด
โพรเจกต์ การบันทึกโพรเจกต์ เป็นต้น หัวข้อนี้จะเป็นการอธิบายการใช้งาน
สภาพแวดล้อมของวิชวลเบสิกเบื้องต้นที่ควรทราบ

สำหรับในส่วนที่ไม่ได้อธิบาย จะอธิบายเมื่อเนื้อหามีความสัมพันธ์กัน
กับสภาพแวดลอ้มของวชิวลเบสกิ ในส่วนนัน้ ๆ  จะทำใหท้ำความเขา้ใจไดไ้ม่ยาก
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รูปที่ 1-2 แสดงสภาพแวดล้อมของโปรแกรมวิชวลเบสิก 6.0

และรู้ลึกอย่างต่อเนื่องแถมรวดเร็ว ส่วนเมนูบาร์จะไม่อธิบายโดยตรง เนื่องจาก
คำสั่งในเมนูบาร์มีการใช้งานเกือบทั้งหมดได้ถูกรวบรวมไว้ในทูลบาร์อยู่แล้ว
เมื่อการกล่าวถึงการใช้งานทูลบาร์ใด ผู้เขียนจะอ้างถึงคำสั่งในเมนูบาร์นั้นด้วย

 :: ÀπÈ“µË“ß™‘Èπß“π„À¡Ë

หน้าต่าง New Project จะปรากฏขึ้นมา เมื่อเริ่มต้นใช้งานโปรแกรม
วิชวลเบสิก หรือเลือกได้จากเมนู File>New Project ไดอะล็อกบล็อกนี้ ก็จะ
แสดงชนิดของแอปพลิเคชันที่ต้องการพัฒนา
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ไอคอนแต่ละตัว จะแทนประเภทของแอปพลิเคชัน ซึ่งสื่อด้วยชื่อ หรือ
นามสกุล ที่ปรากฏประจำตัวไอคอนนั้น ๆ โดยปกติแล้วแอปพลิเคชันชนิด
Standard.EXE จะเป็นแอปพลิเคชันพื้นฐานที่ควรจะเริ่มต้นพัฒนา เพราะเป็น
แอปพลเิคชนัที่ใช้งานทั่วไป ไฟลท์ี่ไดจ้ากการคอมไพล์ จะมนีามสกลุ .exe

สำหรับรายละเอยีดแอปพลเิคชันชนดิอ่ืน ๆ มดัีงน้ี

äÍ¤Í¹ ¤ÇÒÁËÁÒÂ

ãªé¾Ñ²¹ÒáÍ»¾ÅÔà¤ªÑ¹·ÑèÇä» áÅÐãªéÊÃéÒ§â»Ãá¡ÃÁáºº¡ÃÒ¿Ô¡·ÑèÇ æ
ä»
ã ª é ¾ Ñ ² ¹ Ò á Í » ¾ Å Ô à ¤ ª Ñ ¹ · Õ è Ê Ò Á Ò Ã ¶ ã ª é § Ò ¹
áÅÐàª×èÍÁâÂ§¡ÑºáÍ»¾ÅÔà¤ªÑ¹Í×è¹ ·ÕèÊ¹ÑºÊ¹Ø¹à·¤â¹âÅÂÕ ActiveX

à»ç¹áÍ»¾ÅÔà¤ªÑ¹ª¹Ô´à´ÕÂÇ¡Ñº ActiveX.EXE
áµè¨Ðà¡çºÍÂÙ èã¹ÅÑ¡É³Ð ä¿ÅìäÅºÃÒÃÕ *.dll (In-Process)
« Ö è § ä Á è Ê Ò Á Ò Ã ¶ Ã Ñ ¹ ä ´ é ´ é Ç Â µ Ñ Ç Á Ñ ¹ à Í §
¨ÐµéÍ§¶Ù¡àÃÕÂ¡ãªé§Ò¹¨Ò¡áÍ»¾ÅÔà¤ªÑ¹Í×è¹ æ

รูปที่ 1-3 แสดงไดอะล็อกบล็อก New Project
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äÍ¤Í¹ ¤ÇÒÁËÁÒÂ

ãªéÊÃéÒ§¤Í¹â·ÃÅ ActiveX ¢Öé¹ÁÒãªé§Ò¹àÍ§

à»ç¹à¤Ã×èÍ§Á×Í·ÕèÍÓ¹ÇÂ¤ÇÒÁÊÐ´Ç¡ã¹¡ÒÃÊÃéÒ§áÍ»¾ÅÔà¤ªÑ¹ â´ÂÁÑ¹
¨ÐÊÃéÒ§Í§¤ì»ÃÐ¡ÍºËÅÑ¡ æ ¢Í§áÍ»¾ÅÔà¤ªÑ¹
¨ Ò ¡ ¢ Ñ é ¹ µ Í ¹ · Õ è ä ´ é à Å × Í ¡ ä Ç é
áÍ»¾ÅÔà¤ªÑ¹·Õ èä´é¨ÐÁÕ¤ÇÒÁÊÁºÙÃ³ìã¹ÃÐ´ÑºË¹Öè§à·èÒ¹Ñ é¹
¨ÐµéÍ§»ÃÑº»ÃØ§ à¾ÔèÁàµÔÁáÅÐá¡éä¢ à¾×èÍ·ÓãËéà»ç¹ÁÒµÃ°Ò¹ÂÔè§¢Öé¹
¶×Íä´éÇ èÒà»ç¹à¤Ã× èÍ§Á×Í ·Õ èª èÇÂãËéâ»Ãá¡ÃÁàÁÍÃì
àÃÔèÁµé¹â¾Ãà¨¡µìä é́à»ç¹ÍÂèÒ§ ṌãªéÊÃéÒ§â»Ãá¡ÃÁ é́Ò¹¡ÒÃ Ñ́̈ ¡ÒÃ àªè¹ µỐ µèÍ¡Ñº°Ò¹¢éÍÁÙÅ

à»ç¹ª¹Ố â¾Ãà¨¡µì·Õèà»ç¹áºº¿ÍÃìÁ à¾×èÍµỐ µèÍ¡Ñº°Ò¹¢éÍÁÙÅ â´Â¼èÒ¹
·Ò§¤Í¹â·ÃÅ ADO Data Control

áÍ»¾ÅÔà¤ªÑ¹ª¹Ố ·ÕèãªÑ¡ÑºàÇçºà«ÔÃì¿àÇÍÃì

à¾ÔèÁàµÔÁâ»Ãá¡ÃÁªèÇÂà¢éÒä»ã¹ÊÀÒÇÐáÇ´ÅéÍÁ¢Í§ÇÔªÇÅàºÊÔ¡
à¾×èÍà¾ÔèÁ »ÃÐÊÔ· Ô̧ÀÒ¾ ã¹¡ÒÃ·Ó§Ò¹

ãªéÊÃéÒ§áÍ»¾ÅÔà¤ªÑ¹·Õè·Ó§Ò¹º¹ÍÔ¹à·ÍÃìà¹çµ ̈ Ðà¡çºÍÂÙèã¹ä¿Åì *.dll
äÁèÊÒÁÒÃ¶ÃÑ¹ é́ÇÂµÑÇÁÑ¹àÍ§ä é́ µéÍ§ãËéáÍ»¾ÅÔà¤ªÑ¹·ÕèÊ¹ÑºÊ¹Ø¹
à·¤â¹âÅÂÕ ActiveX  àÃÕÂ¡ãªé§Ò¹á·¹

ãªéÊÃéÒ§áÍ»¾ÅÔà¤ªÑ¹ª¹Ố ·Õè·Ó§Ò¹º¹ÍÔ¹à·ÍÃìà¹çµ ̈ Ðà¡çºÍÂÙèã¹ä¿Åì
áºº *.exe äÁèÊÒÁÒÃ¶ÃÑ¹´éÇÂµÑÇàÍ§ä´é
áµèà«ÔÃì¿àÇÍÃì̈ ÐµéÍ§Ê¹ÑºÊ¹Ø¹ à·¤â¹âÅÂÕ  ActiveX ́ éÇÂàªè¹¡Ñ¹

ãªé¾Ñ²¹ÒáÍ»¾ÅÔà¤ªÑ¹ÃÙ»áºº¢Í§àÍ¡ÊÒÃ DynamicHTML «Öè§à»ç¹
ÁÒµÃ°Ò¹ãËÁè¢Í§¡ÒÃáÊ´§¼Åº¹àÇçºà¾¨

ã ª é ¾ Ñ ² ¹ Ò á Í » ¾ Å Ô à ¤ ª Ñ ¹ ã ¹ Ã Ð ´ Ñ º Ê ¶ Ò ¹ » Ã Ð ¡ Í º ¡ Ò Ã
«Ö è§â»Ãá¡ÃÁ¨Ðà¾Ô èÁ àµÔÁ¤Í¹â·ÃÅ ActiveX
ÍÕ¡¨Ó¹Ç¹Ë¹Ö è§¢Ö é¹ÁÒâ´ÂÍÑµâ¹ÁÑµÔ «Ö è§ãªé§Ò¹¡Ñº
â»Ãá¡ÃÁàÁÍÃìÁ×ÍÍÒªÕ¾·ÕèÁÕ¤ÇÒÁàªÕèÂÇªÒ-ÁÒ¡¾ÍÊÁ¤ÇÃ
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ไดอะลอ็กบลอ็ก New Project มีอยูอ่กี 2 แทบ็ ดังนี้

แสดงรายชื่อโพรเจกต์ที่ถูกพัฒนาครั้งหลังสุด เพื่ออำนวย
ความสะดวกให้กับผู้ใช้งาน

  แทบ็ Existing
  แทบ็  Recent

ใช้สำหรับเปิดโพรเจกต์ที่มีอยู่แล้ว

รูปที่ 1.4 แสดงแท็บ Existing และ Recent ในไดอะล็อกบล็อก New Project

 :: ∑Ÿ≈∫“√Ï
ทูลบาร์ เป็นส่วนที่รวบรวมคำสั่งที่ใช้งานในการพัฒนาแอปพลิเคชัน

บ่อยทีสุ่ด จะมีคำสัง่เหมอืนกบัเมนบูาร์ ซ่ึงสามารถทีจ่ะปรับแตง่ทลูบาร์นีไ้ด้ โดย
การเลอืกเมน ูView>Toolbars สำหรับช่ือของปุ่มต่าง ๆ   ท่ีอยู่บนทูลบาร์ไม่จำเป็น
ต้องไปจดจำว่ามันแทนคำสั่งอะไร เพียงแต่ให้เลื ่อนเมาส์ไปวางบนปุ่มนั้น
ซักประมาณ 2 - 3 วินาที จะมีทูลทิปขึ้นมา เพื่อบอกคำสั่งที่ปุ่มนั้นทดแทนอยู่
โดยทลูบาร์สามารถแบง่ออกไดเ้ป็น 4 กลุม่ใหญ ่ๆ คอื
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·ÙÅºÒÃì Standard1

·ÙÅºÒÃì Edit2

·ÙÅºÒÃì Debug3

·ÙÅºÒÃì Form Edit4

ถือได้ว่าเป็นทูลบาร์ปกติ ที่ต้องใช้งานทุกครั้งและบ่อยที่สุด เนื่องจาก
ประกอบไปดว้ย คำสัง่ทีเ่กีย่วกบัการใชง้านทัว่ ๆ ไป ซ่ึงรวบรวมคำสัง่มาจาก
เมนู File, Project, Debug, Run, Tool เป็นต้น

รูปท่ี 1.5.1 แสดงรายการทูลบาร์ Standard

จะใชง้านกต็่อเมื่อเริ่มเขยีนโคด้ใน code editor คำสั่งหลกัของทลูบาร์กลุ่มนี้
คอื Cut, Paste ซ่ึงกค็ือคำสั่งในเมน ูEdit นั่นเอง

รูปท่ี 1.5.2 แสดงรายการทูลบาร์ Edit

ใช้ในการตรวจสอบโค้ดว่าทำงานได้ตามความต้องการหรือไม่

รูปที่ 1.5.3 แสดงรายการทูลบาร์ Debug

จะใช้งาน เมื่อต้องการปรับขนาด ย้าย เปลี่ยนตำแหน่งคอนโทรลที่อยู่
บนฟอรม์ เปน็คำสัง่ทีเ่หมอืนกบัเมน ูFormat

รูปท่ี 1.5.4 แสดงรายการทูลบาร์ Form Edit
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 :: ∑Ÿ≈∫≈ÁÕ°

ทูลบล็อก เป็นสิ่งที่รวบรวมคอนโทรล ที่ใช้ในการพัฒนาแอปพลิเคชัน
คอนโทรลเป็นสิ่งที่อยู่เบื้องหลังความสำเร็จของโปรแกรมวิชวลเบสิกทุกเวอร์ชัน
เพราะมันได้ซ่อนความยุ่งยากด้านเทคนิคไว้ภายใต้การเลือกใช้งานที่แสนง่าย
ตัวคอนโทรลสามารถแยกออกเปน็สว่นใหญ ่ๆ ได ้2 ส่วน คอื

  คอนโทรลภายใน

  คอนโทรล ActiveX

รูปที่ 1.6 แสดงการเพิ่มเติมคอนโทรล ActiveX เข้ามาในทูลบล็อก

เป็นชุดคอนโทรลมาตรฐานทกุครัง้ทีท่ำงาน คอนโทรลจะถกูโหลดขึน้มาอตัโนมตัิ
ซ่ึงสามารถเลอืกใชง้านคอนโทรลกลุม่น้ีได้ทันท ีโดยทีไ่ม่ต้องใชไ้ฟลเ์พิม่เตมิ และ
ไม่สามารถถอดคอนโทรลชดุน้ี ออกจากสภาวะแวดลอ้มของโปรแกรมได ้ เป็นชุด
คอนโทรลที่ใช้งานทั่วไปในทกุ ๆ แอปพลเิคชนั

เป็นชุดคอนโทรลทีใ่ส่เทคโนโลย ีActiveX เข้าไปด้วย ถือว่าเป็นคอนโทรลเพิม่เติม
ถ้าต้องการใช้งาน จะต้องใช้ไฟล์ *.ocx ประจำแต่ละคอนโทรลเพิ่มเข้ามา
โดยการเลอืกเมน ูProject>Components
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 :: øÕ√Ï¡ 1 (Form1)

ฟอร์ม 1 ถอืได้วา่เปน็อ็อบเจกตต์วัแรกทีไ่ด้ใช้งาน จะตอ้งใช้งานรว่มกบั
คอนโทรลประกอบกนัขึน้มาเปน็แอปพลเิคชนัหนึง่ ๆ  ฟอร์มจัดไดว้า่เปน็ตวับรรจุ
ของคอนโทรลอื่น ๆ และทุกครั้งที่เปิดโปรแกรมวิชวลเบสิกขึ้นมา ฟอร์มว่าง ๆ
จะถกูโหลดขึ้นมาเสมอ ซ่ึงจะมคีวามสมัพันธก์ับหนา้ตา่ง Project Explorer  ด้วย
ใน 1 โพรเจกต ์จะประกอบไปดว้ยอยา่งนอ้ยท่ีสุด 1 ฟอร์ม แต่มีโพรเจกตบ์างชนดิ
จะไมมี่ฟอรม์ เชน่ พวกนามสกลุ *.dll เป็นตน้

รูปที่ 1.7 แสดงฟอร์มว่าง ๆ ในสภาพแวดล้อมของโปรแกรมวิชวลเบสิก

 :: ÀπÈ“µË“ß Project Explorer
หน้าต่าง Project Explerer ช่วยให้สามารถบริหารจัดการหลาย ๆ

โพรเจกตไ์ด้ ในเวลาเดยีวกนัอยา่งมปีระสิทธภิาพ เนือ่งจากโปรแกรมวชิวลเบสกิ
สนับสนุน การพัฒนาแบบหลายชิ้นงาน ซึ่งยังสามารถบันทึกโพรเจกต์เป็นกลุ่ม
งานที่มีนามสกุลเป็น *.vbg โดยที่โปรแกรมจะจัดกลุ่มโพรเจกต์ต่าง ๆ ให้โดย
อัตโนมตัิ ซ่ึงถา้มีโพรเจกตเ์ดยีวกจ็ะมนีามสกลุ *.vbp
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หน้าต่าง Project Explorer แสดงรายการองค์ประกอบของแต่ละ
โพรเจกต์แบบโครงร่างต้นไม้ ตัวโพรเจกต์ถือว่าเป็นตัวแทนแอปพลิเคชันทั้งหมด
ซ่ึงจะอยูส่่วนบนสดุ ถัดมาจะแสดงองคป์ระกอบของโพรเจกตน์ัน้ ๆ วา่ประกอบ
ไปด้วยอะไรบ้าง เช่น มีฟอร์มกี่ฟอร์ม มีกี่โมดูล เป็นต้น ถ้ามี 2 โพรเจกต์ขึ้นไป
ก็จะแสดงแยกออกเป็นส่วนต่างหากอีกโพรเจกต์ ถ้าต้องการใช้งานส่วนใดของ
โพรเจกต์ สามารถคลิกเลือกได้โดยตรง ซึ่งจะต้องพิจารณาด้วยว่า รายการใด
อยู่ภายในโครงสร้างของโพรเจกต์ไหน ก็จะเป็นองค์ประกอบของโพรเจกต์นั้น
ซึ่งแสดงดงัรูปที่ 1.8 และรปูที่ 1.9

รูปที่ 1.8 รูปที่ 1.9
แสดงแบบโพรเจกตเ์ดียว แสดงแบบหลายโพรเจกต์

สำหรบัรายการชนดิของออ็บเจกตท์ี่ปรากฏอยูใ่นหนา้ตา่ง Project Ex-
plorer มีหลายชนิดที่เป็นสิ่งจำเป็น ในการเริ่มต้นสร้างแอปพลิเคชันหนึ่ง ๆ
ให้มีความสมบูรณ์มากยิ่งขึ้น

ในโพรเจกต์หนึ่งจะประกอบไปด้วยอย่างน้อยที่สุด 1 ฟอร์ม ยกเว้น
กรณีที่สร้างแอปพลิเคชัน ชนิด *.dll ไม่จำเป็นจะต้องมีฟอร์ม ถ้าต้องการเพิ่ม
ฟอร์มเข้าไปในโพรเจกต์ให้ทำดังนี้

 เลือ่นเมาสไ์ปบริเวณหนา้ตา่ง Project Explorer
 คลิกขวา เพือ่แสดง pop-up เมนู
 เลอืกคำสัง่ Add>Form
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ª×èÍÃÙ»áºº ¤ÇÒÁËÁÒÂ

áÍ»¾ÅÔà¤ªÑ¹·Õ è¾ Ñ²¹ÒÍÂÙ è  ÍÒ¨ÁÕâ¾Ãà¨¡µìà´ÕÂÇ
ËÃ×ÍËÅÒÂâ¾Ãà¨¡µì¡çä´é â´Â»¡µÔÁÕ¹ÒÁÊ¡ØÅ *.vbp
¶éÒÁÕËÅÒÂâ¾Ãà¨¡µì¹ÒÁÊ¡ØÅà»ç¹ *.vbg

à»ç¹¤Í¹â·ÃÅ ActiveX ·ÕèÊÃéÒ§¢Öé¹ÁÒ ÁÕ¹ÒÁÊ¡ØÅ *.ctl

Project (n)

Form (n) à»ç¹¿ÍÃìÁ·ÕèÁÕÍÂÙèã¹â¾Ãà¨¡µì ã¹ 1 â¾Ãà¨¡µì ÍÒ¨ÁÕÁÒ¡¡ÇèÒ 1
¿ÍÃìÁ¡çä é́ «Öè§»¡µÔáÅéÇ¨ÐÁÕ¹ÒÁÊ¡ØÅ *.frm

Modules ·Õ è à¡ çºªØ´¤ÓÊÑ è§ ËÃ×ÍÃÙ·Õ¹·Õ è à¢ ÕÂ¹¢Ö é¹ÁÒ
¨Ðà¡çººÑ¹·Ö¡äÇéãªé§Ò¹ÀÒÂËÅÑ§ä´é ÍÕ¡´éÇÂ
â»Ãá¡ÃÁàÁÍÃìÁÑ¡¨Ðà¡çº¤ÓÊÑè§ ËÃ×Íâ¾Ã«ÕàÂÍÃì·Õèãªé§Ò¹ºèÍÂ
äÇéà»ç¹âÁ Ù́Å «Öè§ÁÕ¹ÒÁÊ¡ØÅ *.basClass modules à»ç¹âÁ´ÙÅª¹Ô´¾ÔàÈÉ ·Õ èÁ ÕÅ Ñ¡É³Ðà»ç¹ÍçÍºà¨¡µì
·ÕèÊÒÁÒÃ¶ÊÃéÒ§¢Öé¹ÁÒä é́ ÁÕ¹ÒÁÊ¡ØÅ *.cls

User controls

 :: ÀπÈ“µË“ß§ÿ≥ ¡∫—µ‘

หนา้ตา่งคณุสมบตั ิจะมคีวามสมัพนัธก์บัฟอร์ม คอนโทรล ทีมี่สถานะ
แอกทีฟ หรือได้รับความสนใจในขณะนั้น ซึ่งโปรแกรมจะเปลี่ยนแปลงหน้าต่าง
คณุสมบตั ิใหต้รงกบัอ็อบเจกตโ์ดยอตัโนมตัิ

โดยปกตแิลว้ โปรแกรมวชิวลเบสกิจะตัง้คา่ปกตใิหโ้ดยอตัโนมตั ิ ซ่ึงจะ
มีทัง้ส่วนทีเ่หมาะสมดอียู่แล้ว และสว่นทีโ่ปรแกรมตัง้คา่กลาง ๆ  เอาไวใ้ห้ จะมีทัง้
ที่ต้องปรับแต่งและไม่ต้องยุ่งเกี่ยว คุณสมบัติบางตัวเท่านั้นที่ควรปรับแต่งค่า
เร่ิมต้นในหนา้ต่างคณุสมบัติน้ี อีกส่วนหนึง่จะใชวิ้ธีการเขยีนโคด้ เพ่ือปรับแตง่ค่า
คณุสมบัต ิ ซ่ึงเปน็เทคนคิทีท่างไมโครซอฟตแ์นะนำใหใ้ช้งาน

ผู้ใช้งานสามารถเลือกรายการคอนโทรล ได้จากหน้าต่างคุณสมบัติ
เช่นกัน โดยคลิกที่ drop-down list box จะแสดงรายการคอนโทรลที่ใช้งานอยู่
และยังสามารถทราบความหมายเบื้องต้นของคุณสมบัติที่เลือก โดยมีคำนิยาม
สัน้ ๆ ที่อยูด่้านลา่งอกีดว้ย

ในหนา้ต่างคณุสมบติั ประกอบไปดว้ย 2 แทบ็ ดังน้ี
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  แทบ็ Alphabetic

  แทบ็ Categorized

เปน็แทบ็ที่แสดงรายการคณุสมบตัิ เรยีงตามตวัอกัษร
ในภาษาอังกฤษ
เป็นแท็บที่แสดงรายการคุณสมบัติ โดยจัดกลุ่มของ
คณุสมบตัทิีมี่หนา้ทีค่ล้ายกนั หรือมีความสมัพันธก์นั

รูปที่ 1.10
หน้าต่างคุณสมบัติแบบ Alphabetic

รูปที่ 1.11
หน้าต่างคุณสมบัติแบบ Categorized

 :: ÀπÈ“µË“ß Form Layout

เมื่อเคลื่อนย้ายฟอร์มจำลองแล้ว ฟอร์มจริงจะไม่ได้
เคลื่อนย้ายไปยังตำแหน่งดังกล่าว เพราะว่ามันจะมี
ผลในขณะรนัเทา่นัน้ เรียกวา่ ช่วง runtime ส่วนฟอรม์
ใหญ ่ที่เหน็อยู่กลาางจอภาพ จะเปน็ชว่ง design time
เม่ือทำงาน จะรูว้่าฟอรม์อยูต่รงไหนของจอภาพ

รูปที่ 1.12
หน้าต่าง Form Layout

หนา้ตา่ง Form Layout ใช้กำหนดตำแหนง่ของฟอรม์ ทีจ่ะปรากฏบน
จอภาพในขณะทำงาน สามารถกำหนดตำแหน่งของฟอร์ม โดยการย้ายฟอร์ม
จำลองทีอ่ยู่ในจอภาพ ด้วยการลากเมาสไ์ปยังตำแหนง่ท่ีต้องการ มีข้อสังเกต  คือ
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 :: ÀπÈ“µË“ß· ¥ßº≈∑—π∑’ (Immediate Window)

เป็นหน้าต่างที่ให้ประโยชน์ ในกรณีที่ต้องการทราบผลโดยทันที เช่น
การทดสอบโพรซเียอร ์ เม่ือส่ังรันโพรเจกต ์หนา้ตา่งนี ้จะปรากฏขึน้โดยอตัโนมตัิ
สามารถเรยีกใชง้าน โดยเลอืกไปทีเ่มน ูView>Immediate Window

รูปที่ 1-13 แสดงหน้าต่าง Immediate

 ::  ¿“æ·«¥≈ÈÕ¡‚¥¬√«¡¢Õß‚ª√·°√¡«‘™«≈‡∫ ‘°

สภาพแวดล้อมของโปรแกรมวิชวลเบสิก สามารถแบ่งได้ 2 ประเภท
ดังต่อไปนี้

âËÁ´ MDI1

รูปที่ 1-14 แสดงสภาพแวดล้อมแบบ MDI

โหมด MDI (Multiple Docu-
ment Interface) จะแสดงหนา้
ต่างในรปูแบบเปน็หนึง่เดยีวกนั
ซ ึ ่งเป ็นสภาพแวดล้อมปกติ
ของโปรแกรมวิชวลเบสิก
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โหมด SDI (Single Document Interface) จะแสดงหน้าต่างที่มีลักษณะ
เป็นอิสระตอ่กัน แตย่งัคงมคีวามสมัพันธก์นั เหมอืนกบัโหมด MDI แตจ่ะใช้
พัฒนาแอปพลิเคชันอีกชนิดหนึ่ง

âËÁ´ SDI2

รูปที่ 1-15 แสดงสภาพแวดล้อมแบบ SDI
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:: ¸ÕÃÐÈÑ¡ Ốì  ÊØâªµÔ¹Ñ¹·ì :: »ÃÐÂØ·¸  ÍÔ¹áº¹ ::

 :: °“√‡ª≈’Ë¬π ¿“æ·«¥≈ÈÕ¡®“° MDI ‡ªÁπ SDI

รูปที่ 1-16 แสดงการเปลี่ยนสภาพแวดล้อมจาก MDI เป็น SDI

 เลือกเมน ูTools>Options จะปรากฏไดอะลอ็กบลอ็ก Options
 คลิกที่แทบ็ Advanced เลอืก SDI Development Environment
 คลกิทีปุ่่ม OK

 :: °“√ª√—∫·µËß ¿“æ·«¥≈ÈÕ¡‚ª√·°√¡„ÀÈµ√ß°—∫°“√„™Èß“π

ในการใช้งานจริง ๆ แล้ว ไม่จำเป็นต้องแสดงผลทุกหน้าต่างพร้อมกัน
เพราะจะทำใหพ้ืน้ทีใ่นการทำงานมนีอ้ย เม่ือพัฒนาแอปพลเิคชนัไปในระยะหนึง่
จะพบว่าสภาพแวดล้อมแบบใดเหมาะสมกับโพรเจกต์ และจะแสดงอะไรบ้าง
ผู้เขียนจะพยายามปิดหน้าต่างที่ไม่ได้ใช้งานเสมอ เพราะถือว่า ถ้าเราจัดโต๊ะ
ทำงานให้เป็นระเบียบเรียบร้อย มันจะส่งผลให้การพัฒนาแอปพลิเคชัน สะดวก
และรวดเร็วขึ้นไปอีกระดับหนึ่งอีกด้วย
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   :: ¢ÈÕµ°≈ß„π°“√„™ÈÀπ—ß ◊Õ‡≈Ë¡π’È

การที ่จะเร ิ ่มเขียนแอปพลิเคชันอย่างแท้จริง จะต้องมีแนวทาง
การเขยีนโปรแกรม ดงันี้

ซอร์สโค้ดของโปรแกรม จะใช้ฟอนต์ที่มีลักษณะแตกต่างจากฟอนต์ปกติ
และใช้การเว้นวรรคตัดคำ ให้ตรงกับไวยากรณ์ที่วิชวลเบสิกยอมรับ หรือ
กำหนดมา เชน่

  ซอรส์โคด้

Private Sub Command1_Click ( )
Text1.Text = “วิศวกร นอกคอก”
End Sub

  ไวยากรณ์
สำหรับไวยากรณ์ จะใชตั้วเข้มเพ่ือแทน รูปแบบ (format) คำส่ัง (statements)
ฟงักชั์น (functions) คำสงวน (keyword) ให้ตรงกบัรูปแบบการนำเสนอของ
msdn Library เพื่อให้ผู้ใช้งานมีความคุ้นเคย และจะใช้ตัวธรรมดา เพื่อ
แสดงสว่นของ ตวัแปร พารามเิตอร ์อารก์วิเมนต ์เชน่

Form1.Enabled [= boolean ]

  วงเล็บปิด [  ]
วงเลบ็ปิด [ ] จะไม่พิมพ์ลงไป และตวัแปรทีอ่ยู่ในวงเลบ็ หมายถงึ ผู้อ่านจะใส่
หรือไม่ใส่ค่าก็ได้ ขึ้นอยู่กับการใช้งาน เช่น

Object.Caption [= string]  หรือ  Object.Circle [Step](x, y), radius, [color, start, end]

วงเลบ็ปีกกา {  } ไม่ต้องพมิพ์ลงไป และตวัแปรทีอ่ยู่ในวงเลบ็ดังกลา่ว จะถกู
คัน่ดว้ยเครือ่งหมาย  |  ซ่ึงจะตอ้งใสต่วัแปรตวัใดตวัหนึง่ในวงเลบ็น้ัน เช่น

  วงเล็บปีกกา { }

{Dim | Private} varname As datatypes
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Private Sub Command2_Click ( )
Text1.Text = “?×〈ϒ©∇?ϒ?⎡⁄∝∇??×〈ϒ©∇?ϒ?⎡⁄∝∇??×〈ϒ©∇?ϒ?⎡⁄∝∇??×〈ϒ©∇?ϒ?⎡⁄∝∇??×〈ϒ©∇?ϒ?⎡⁄∝∇? “

End Sub

Private Sub Command1_Click ( )
Text1.Text = “ Love You…”

End Sub

 คำนยิาม
คำนยิาม หมายถงึ คำหรอืข้อความ ที่ใช้สำหรบักลา่วอา้งองิ ซ่ึงมคีวามหมาย
ดังต่อไปนี้

ค่าที่โปรแกรมวิชวลเบสิกตั้งไว้ให้แล้ว จะเปลี่ยนหรือไม่ก็ได้
ข้อกำหนดเพิ่มเติมของการใช้งานตัวแปรนั้น ๆ จะใส่ หรือไม่ใส่ก็ได้
เป็นคำที่ผู้เขียนใช้แทนโปรแกรมทั่ว ๆ ไปในท้องตลาด ซึ่งอาจรวมถึง
โปรแกรมที่ทำงานภายใต้ทุกระบบปฏิบัติการ
การแปลงโพรเจกต์ให้เป็นแอปพลิเคชันที่สมบูรณ์ ซึ่งโดยปกติแล้ว
จะมี นามสกุลเป็น *.exe
ตัวแปร ค่าคงที่ หรือพารามิเตอร์ ที่ใช้สำหรับส่งค่าเข้าไปในฟังก์ชัน
หรอืส่งคา่เขา้ไปในโพรซเียอร์
ช่วงเวลาทีโ่ปรแกรมเมอรอ์อกแบบอินเตอร์เฟส หรือ เขียนโคด้ อาจใช้
คำว่าขณะออกแบบก็ได้
คำสงวน หมายถึงคำ หรือข้อความท่ีโปรแกรมวิชวลเบสิก นำไปใช้เป็น
ชุดคำสัง่ คอนโทรล อ็อบเจกต ์ฟงักชั์น ซ่ึงคำเหลา่นี ้จะไมส่ามารถนำ
ไปใช้ตั้งชื่อ ที่ไม่ใช่หน้าที่ หรือไวยากรณ์ของมันได้
ช่วงเวลาทีโ่ปรแกรมเมอรท์ดสอบโคด้ หรือ กำลังรันโพรเจกตอ์ยู่จะไม่
สามารถแก้ไขโค้ดได้ โดยการกดปุ่ม F5 หรือกดปุ่มรัน
ช้ินงานซอรส์โคด้ของโปรแกรมทีย่ังไมไ่ดถู้กแปลง

 compile

 default
 optional
 application

 argument

 design time

 keyword

 run time

 project

 :: °“√ª√—∫·µËß„ÀÈÕË“π‚§È¥¿“…“‰∑¬‰¥È

ลองมาดโูคด้ตามรายละเอยีด ดงันี้

พิมพ์ภาษาไทย แต่ผลลัพธ์ออกมาเป็นอักขระ
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ขัน้ตอนการปรบัแตง่ ทำไดด้งันี้

รูปที่ 1 - 17 แสดงการปรับแต่งให้โปรแกรมวิชวลเบสิกอ่านภาษาไทยได้

 เลอืกเมน ูTools>Options
 คลิกทีแ่ทบ็ Editor Format  เลือกรายละเอยีดตา่ง ๆ ดังรูปท่ี 1-17

 Font : ปรับแตง่เปน็ MS Sans Serif  หรอืฟอนตท์ี่ลงทา้ยดว้ย UPC
 Size : แนะนำใหป้รับแตง่เปน็ 10 จะดดูทีีสุ่ด

พอปรับแต่งฟอนต์ที่สนับสนุนภาษาไทย ให้โปรแกรมวิชวลเบสิกอ่าน
ภาษาไทยได ้ในสว่นของซอรส์โคด้กจ็ะสามารถพมิพภ์าษไทยไดท้ันทเีชน่กนั

Private Sub Command2_Click ( )
Text1.Text = “ผมรักคณุ... “

End Sub

Private Sub Command1_Click ( )
Text1.Text = “ Love You…”

End Sub พิมพ์ภาษาไทย อ่านภาษาไทย ได้แล้ว
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รูปที่ 1 -18 การเชื่อมโยง 2 โพรซีเยอร์เข้าด้วยกัน และเขียนโค้ดภาษาไทย

ตอ่ไปเปน็ตวัอยา่งทีแ่สดงใหเ้หน็การเชือ่มโยง 2 โพรซเียอรเ์ขา้ดว้ยกนั
ใหว้าดอนิเตอรเ์ฟส และเขยีนโคด้กำกบั ดังรูปที ่1 - 8

 :: §«“¡ —¡æ—π∏Ï¢Õß§ÿ≥ ¡∫—µ‘ ‡¡∑ÁÕ¥ ·≈–Õ‘‡«πµÏ

ก่อนท่ีจะทำการออกแบบแอปพลเิคชันของการทำงานตา่ง ๆ  จะต้องทำ
ความคุ้นเคยกับความสัมพันธ์ทั้ง 3 ส่วน คือ คุณสมบัติ (properties) เมท็อด
(method ) และอเิวนต ์(event) ให้ดเีสียกอ่น เพือ่จะไดไ้ม่ตอ้งสับสน ในการกลา่ว
อ้างถงึ รวมถงึรปูแบบของการใชง้านดว้ย
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การกำหนดคุณสมบัติของแต่ละชิ้นงานจะไม่เหมือนกัน ขึ้นอยู่กับว่าจะนำ
คอนโทรลไหนมาวาดลงบนฟอรม์ จะอธบิายใหท้ราบไดจ้ากบทตอ่ ๆ ไป

¤Ø³ÊÁºÑµÔ1

เป็นคำสั่งเฉพาะตัวของอ็อบเจกต์ มีทั้งใช้กับตัวเอง และใช้กับอ็อบเจกต์อื่น
เชน่ method “clear” ใช้ไดก้บั ListBox, ComboBox เปน็ตน้

àÁ·çÍ´2

เป็นเหตกุารณท์ีเ่กดิขึน้กบัตวัออ็บเจกต ์ เพือ่ตอบสนองการใชง้าน
ÍÔàÇ¹µì3

ลองมาดูตัวอย่าง ที่แสดงถึงความสัมพันธ์ทั้ง 3 ส่วนเข้าด้วยกัน คือ
คณุสมบตัิ (properties) เมทอ็ด (method ) และอเิวนต ์(event) จะใชค้อนโทรล
ที่ชื่อว่า CommandButton เป็นตวัแสดงความสมัพันธ์

รูปที่ 1-19 แสดงการกำหนดคุณสมบัติ

CmdOk.Caption = “ตกลง”  เปน็การกำหนดคณุสมบตัิ Caption ของ CmdOk
CmdOk.Hight = 525      เปน็การกำหนดคณุสมบัต ิHight ของ CmdOk
CmdOk.Width = 1000      เปน็การกำหนดคณุสมบตัิ Width ของ CmdOk
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Note !
â»Ã´ÊÑ§à¡µÇèÒ¢éÍÁÙÅª¹Ố ¢éÍ¤ÇÒÁ ̈ ÐµéÍ§ÁÕà¤Ã×èÍ§ËÁÒÂ “xxxxxx”  »Ố ¢éÍÁÙÅ¹Ñé¹ é́ÇÂ
áµè¡Ñº¢éÍÁÙÅª¹Ố µÑÇàÅ¢äÁè̈ Óà»ç¹µéÍ§ÁÕ “xxxxxx” »Ố ¢éÍÁÙÅ¹Ñé¹ é́ÇÂ

รูปที่ 1-20 แสดงการกำหนดเมทอ็ด

การส่ังให้คอนโทรลปุม่คำส่ังช่ือ CmdOk ย้ายไปทีต่ำแหนง่ 0, 0 ทำงาน
ตามที่ต้องการ

รูปท่ี 1-21 แสดงการเกิดเหตุการณ์ CmdOk_Click ( ) ขึ้นมา

เกิดเหตุการณ ์CmdOk_Click ( ) ขึ้นมา
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ถ้าต้องการตอบสนองต่อเหตุการณ์ Click ของปุ่มคำสั่ง CmdOk ซึ่ง
ในการตอบสนองตอ่เหตกุารณ ์Click ขา้งตน้ ให้ทดลองใสค่ำสัง่ ดงันี้

Sub CmdOk_Click ( )      คำสั่งที่ตอบสนองต่อเหตุการณ์ Click ของ CmdOk
  CmdOk.Caption = “click”   เปล่ียนคณุสมบัต ิCaption ของ CmdOk เป็น Click
End Sub      จบการตอบสนองตอ่เหตกุารณ ์Click ของ CmdOk

จะพบว่าเมื ่อคลิกเมาส์ที ่ปุ ่มคำสั่งแล้ว
คำวา่ ตกลง จะเปลีย่นไปเปน็ Click แทน

รูปที่ 1-22 แสดงอิเวนต์

 :: √ŸÈ®—°°—∫·Õªæ≈‘‡§™—π™π‘¥ SDI ·≈– MDI

1. อินเตอรเ์ฟสแบบ Single Document Interface (SDI)
2. อินเตอรเ์ฟสแบบ Multiple Document Interface (MDI)
3. อินเตอรเ์ฟสแบบ Windows Explorer

แอปพลเิคชนัทัว่ ๆ ไป ทีท่ำงานอยูภ่ายใตร้ะบบปฏบัิตกิารของวนิโดวส์
จะมอิีนเตอรเ์ฟสหลกั ๆ อยู่ดว้ยกนั 3 แบบ คอื

แอปพลิเคชันแบบ SDI ที่พบเห็นกันอยู่เสมอ คือโปรแกรม NotePad
ในวนิโดวสเ์อง ซ่ึงเปน็ตวัอยา่งของแอปพลเิคชนัชนดิ SDI ได้ดทีีสุ่ด

รูปท่ี 1-23
แสดงอินเตอร์เฟส

แบบ SDI ของ Notepad
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โดยมีลักษณะท่ีเฉพาะ คือ สามารถเปิดเอกสารมาใช้งานได้เพียงคร้ัง ละ
1 ไฟล์เท่านั้น ถ้าต้องการเปิดเอกสารชุดใหม่ ต้องปิดเอกสารเก่าเสียก่อน ซึ่ง
จะไมส่ามารถดเูอกสารพรอ้ม ๆ กนัได ้จึงถกูเรยีกวา่อินเตอรเ์ฟสแบบ SDI

สำหรับแอปพลิเคชันแบบ MDI ท่ีพบเห็นบ่อย คือโปรแกรมในชุดออฟฟิศ
ทั้งหลาย เช่น Microsoft Word, Microsoft Excel เป็นต้น ซึ่งเป็นตัวอย่างของ
แอปพลเิคชนัชนดิ MDI ไดด้ทีีสุ่ด

รูปที่ 1-24  แสดงอินเตอร์เฟสแบบ MDI ของ Microsoft Excel

จะมีลักษณะเฉพาะ คอื สามารถเปดิเอกสารใชง้านไดม้ากกวา่ 1 ไฟล์
ถ้าต้องการเปิดเอกสารชุดใหม่ก็สามารถเปิดได้ทันที ซึ่งมีความเป็นอิสระต่อกัน
จึงถกูเรยีกวา่อนิเตอรเ์ฟสแบบ MDI ซ่ึงจะมหีนา้ตา่งเปน็ของตวัเอง ในโปรแกรม
วิชวลเบสิกเรียกว่า ChildForm ดูได้จากรูปที่ 1-24 เป็นสภาพแวดล้อมของ
Microsoft Excel ที่เปิด worksheet 3  ชุดพรอ้มกนั ในแตล่ะ worksheet จะไมมี่
ส่วนเกี่ยวข้องกัน

สำหรับอินเตอร์เฟสแบบ Explorer จะมีลักษณะแบ่งเป็น 2 ฝั่ง คือ
ซ้ายและขวา โดยด้านซ้ายจะมีลักษณะแสดงเป็นโครงร่างต้นไม้ ส่วนด้านขวา
เป็นรายละเอียดของอ็อบเจกต์ที่ถูกเลือกจากฝั่งซ้าย ซึ่งเป็นที่นิยมกันมาก
ในปัจจุบัน
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รูปที่ 1-25 แสดงอินเตอร์เฟสแบบ Explorer ของ Windows Explorer

 :: °“√„™Èß“πøÕ√Ï¡„π√Ÿª·∫∫ MDI

ฟอร์มชนิด MDI เป็นรูปแบบแอปพลเิคชนั ทีป่ระกอบไปดว้ยฟอรม์แม่
ซ่ึงเปน็ตวับรรจฟุอรม์ลูก ถ้าเปรยีบเทยีบกบั Microsoft Excel แลว้ ดูเหมอืนวา่
สภาพแวดลอ้มของ Microsoft Excel คอื ฟอร์มแม่ ส่วน worksheet ทีเ่ปิดขึน้มา
คอื ฟอร์มลูกนัน่เอง

วธิกีารทำฟอรม์ชนดิ MDI มี 2 ขั้นตอน คอื
1. ให้เพ่ิม MDI Form เข้ามาในสภาพแวดลอ้มของโปรแกรมวชิวลเบสิก
2. และจะตอ้งทำใหฟ้อร์มท่ีเหน็ในโปรแกรมเปน็ฟอรม์ลูก

พิจารณาจากรูปที่ 1-26 ให้คลิกขวาที่บริเวณ Form1 (Form1) แล้ว
เลือกคำสัง่ Add>MDI Form หรอืคำสัง่ Project>Add MDIForm เลือกไอคอน
MDI Form
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รูปท่ี 1-26 แสดงการเพิ่ม MDI Form เข้ามาในโปรแกรม

พจิารณาจากรูปท่ี 1-27 ใหสั้งเกตที ่Project Explorer จะพบวา่ไอคอน
ของฟอรม์ปกตกิบั MDI Form จะแตกตา่งกนั

รูปท่ี 1-27 แสดงไอคอนของ Form แบบธรรมดากับชนิด MDI Form

ให้เปลี่ยนคุณสมบัติ MDI
Child ของ Form1 = True
แล้วรันโพรเจกต์ดู จะพบว่า
MDI Form กลายเป็นฟอร์ม
แม่ของแอปพลิเคชัน ส่วน
ฟอร์มปกติ จะเป็นฟอร์มลูก
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รูปที่ 1-28 แสดงการทำงานของโพรเจกต์ชนิด MDI Form

จะพบวา่ไอคอนของฟอรม์ปกตเิปลีย่นไป ซ่ึงสามารถทราบไดว้า่ฟอรม์
ใดเป็นฟอร์มแม่ หรือฟอร์มใดเป็นฟอร์มลูก โดยดูท่ีไอคอนท่ีกำกับอยู่ จากรูปท่ี 1-
28 จะพบว่า Form1 เป็นฟอร์มลูกเพราะไอคอนเล็กมีความเด่นชัด ส่วน
MDIForm1 เป็นฟอร์มแม ่เพราะว่าไอคอนใหญ่เด่นชัด ข้อสังเกตนี้ จะมี
ประโยชน์ในกรณีที่เปลี่ยนชื่อฟอร์มใหม่ และในโพรเจกต์ที่มีฟอร์มหลายฟอร์ม
ซ่ึงจะทำให้ทราบได้ว่าฟอร์มใดเป็นฟอร์มหลัก คุณสมบัติท่ีสำคัญของฟอร์มลูก คือ
จะสามารถเคลื่อนย้ายฟอร์มได้เฉพาะในขอบเขตของฟอร์มแม่เท่านั้น

 :: °“√§‘¥·∫∫π—°‡¢’¬π‚ª√·°√¡
การเขียนโปรแกรมครั้งแรก ผู้เขียนอาจสับสน

วา่โปรแกรมมรูีปแบบใด และจะสรา้งขึน้มาไดอ้ยา่งไร
ในโปรแกรมวชิวลเบสกิ ไม่ต้องกงัวลใจ หนงัสือเลม่นีม้ีคำตอบ
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โปรแกรม คือ ชุดคำสั่งซึ่งทำให้คอมพิวเตอร์ทำงานตามที่ผู้ใช้งานต้องการ
ในการเขยีนโปรแกรมวชิวลเบสกิ ให้ตรวจสอบแตล่ะขัน้ตอน ดงันี้

  โปรแกรมคอือะไร

ข้ันตอนแรกของการเขยีนโปรแกรม คือ ต้องรู้ว่าจะให้โปรแกรมทำอะไร และผู้ใช้งาน
ต้องการอะไร ดูเหมือนง่าย แต่ไม่ได้คำนึงถึงประโยคคำสั่งตรง ๆ ทำให้นักเขียน
โปรแกรม อาจพบกับปัญหาในการสร้างแอปพลิเคชันได้ การออกแบบโปรแกรม
เป็นเหมือนกับการออกแบบหน้าขนม Cake ซึ่งต้องมีการเตรียมการก่อน

 ¡ÒÃÍÍ¡áººâ»Ãá¡ÃÁ

 ¡ÒÃÍÍ¡áººÊèÇ¹µÔ´µèÍ¼Ùéãªé§Ò¹
จากการทีก่ำหนดเปา้หมาย สำหรับการเขยีนโปรแกรมแลว้ ต่อไปส่ิงสำคัญท่ีจะคิด
คือ เก ี ่ยวกับหน้าตา และการประมวลผลข้อมูล หน้าจอที ่สมบูรณ์
และรูปภาพที่ใช้ใน โปรแกรม ซึ่งถูกเรียกว่า ส่วนติดต่อผู้ใช้ของโปรแกรม
ร ว ม ไ ป ถ ึ ง เ ม น ู อ ็ อ บ เ จ ก ต ์
ไดอะล็อกบล็อก ปุ่ม และรูปภาพประกอบ ซ่ึงผู้ใช้งานจะได้เห็นขณะโปรแกรมกำลงั
ทำงาน ระบบการเขียนโปรแกรมของโปรแกรมวิชวลเบสิก ให้สร้างองค์ประกอบ
ทั้งหมดบนวินโดวส์ เหมือนผู้เช่ียวชาญได้อย่างรวดเร็ว ÊÓÃÇ¨µÑÇàÍ§¡èÍ¹ÍÍ¡áººâ»Ãá¡ÃÁ
เมื่อออกแบบโครงงานของการเขียนโปรแกรมแล้ว อาจพบว่าการเขียนส่วนติดต่อ
กับผู้ใช้งาน ที่ต้องการแสดงให้ผู้ใช้เห็นว่ามีประโยชน์มาก ซึ่งยังช่วยให้คิดถึง
กระบวนการทำงานของโปรแกรมอีกด้วย และจะทำให้รู้ว่า อะไรคือเป้าหมายของ
การเขียนโปรแกรม ใครจะเป็นผู้ใช้โปรแกรม โปรแกรมจะมีหน้าตาเป็นอย่างไร
เมื ่อเร ิ ่มทำงาน ผู ้ใช้ต้องป้อนข้อมูลแบบใดเข้าไปในโปรแกรม โปรแกรม
จะประมวลผลอย่างไรและได้ผลลัพธ์เป็นแบบไหน ต้องคิดก่อนเสมอ

 ¡ÒÃÊÃéÒ§â»Ãá¡ÃÁ´éÇÂâ»Ãá¡ÃÁÇÔªÇÅàºÊÔ¡
การสร้างโปรแกรม มีขั้นตอนอยู่ 3 ขั้นตอน คือ
     1. การสร้างส่วนติดต่อผู้ใช้งาน
     2. การตั้งค่าคุณสมบัติ
     3. การเขียนรหัส หรือ โค้ด
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 ÀÒÉÒ¢Í§â»Ãá¡ÃÁÇÔªÇÅàºÊÔ¡
ภาษาในการเขียนโปรแกรมวิชวลเบสิก จะมีประโยคคำสั่ง ฟังก์ชัน และตัวอักษร
พิเศษอีกหลายชนดิ กฎเกณฑ ์และเน้ือหาของภาษาการเขยีนโปรแกรมวชิวลเบสิก
จะเรยีกวา่ รูปแบบการเขียนโปรแกรม (Syntax) จะต้องมีการจัดลำดับของคำ
สำหรับตัวแปลภาษา จะพบว่าความง่ายในการใช้งานโปรแกรมวิชวลเบสิก
เป็นเหตผุลให้ตัวมันเองถกูเลือกให้มาเป็นตัวเขยีนโปรแกรมบนวนิโดวสท่ี์รู้จักกันดี
คือ โปรแกรมด้านตาราง Microsoft Excel

เมื่อสร้างโปรแกรมเรียบร้อยตามวัตถุประสงค์ที่ต้องการแล้ว จะต้องทดสอบ
โปรแกรมที่เขียนอย่างละเอียด โดยการแปลงโค้ดไฟล์โพรเจกต์ให้เป็นไฟล์
ใช้งานทีมี่นามสกลุ *.exe ซ่ึงหมายถงึไฟล์ Execute ทีส่ามารถทำงานได้
โดยไมต่อ้งอยูใ่นสภาพแวดลอ้มของโปรแกรมวชิวลเบสกิอีกตอ่ไป เพือ่นำไป
แจกจ่ายให้กับผู ้ใช้งานภายหลัง ซึ ่งกระบวนการโดยเริ ่มต้น จากการ
ออกแบบและวิเคราะห์เป้าหมายใหม่ ขั้นตอนเหล่านี้ จะอยู่ในวงลูปของ
การพัฒนา การเขียนโปรแกรมที่สมบูรณ์ จะต้องเป็นแบบนี้ทุกโปรแกรม
ซ่ึงมขีัน้ตอน ดงัตอ่ไปนี้

  การทดสอบและแจกจา่ยโปรแกรม

 ¡ÒÃ·´ÊÍºâ»Ãá¡ÃÁ·ÕèÍÍ¡áºº
การทดสอบโปรแกรม เป็นการตรวจสอบสถานะของการทำงานจรงิ เพ่ือตัดสินใจว่า
ทำงานถูกต้องตามวัตถุประสงค์หรือไม่ ซึ่งอาจจะพบปัญหาที่ทำให้โปรแกรม
หยุดทำงานกลางคัน ซึ่งจะเรียกว่าโปรแกรมมีบัก เราต้องหาความผิดพลาดนั้น
ให้พบก่อนจำหน่ายจ่ายแจกไปยังผู้ใช้งาน ในโปรแกรมวิชวลเบสิกมีเครื่องดีบัก
ที่สามารถตรวจจับจุดผิดพลาดในการเขียนโปรแกรมได้เป็นอย่างดี

 ¡ÒÃá»Å§â¤é´ä¿Åìâ¾Ãà¨¡µì
การแปลงโคด้ไฟลโ์พรเจกต ์เม่ือทำการสรา้งและทดสอบโปรแกรมเปน็อยา่งดแีล้ว
ต้องแปลงโค้ดไฟล์โพรเจกต์ ให้เป็นโปรแกรมที่สามารถทำงานด้วยตวัมันเองได้

 ¡ÒÃá¨¡¨èÒÂâ»Ãá¡ÃÁä»ÂÑ§¼Ùéãªé§Ò¹
เม่ือแปลงโค้ดเรียบร้อยแล้ว ต่อไป คือ การแจกจ่ายโปรแกรมไปยังผู้ท่ีต้องการใช้งาน
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จุดประสงค์ของหนังสือเล่มนี้ จะเน้นการนำไปใช้งานให้มากที่สุด
โดยแสดงตัวอย่างประกอบ เพื่อให้ผู้อ่านเห็นภาพได้อย่างชัดเจน แต่ยังไม่ทิ้ง
แนวคิดพื ้นฐานในการใช้งาน และจะละไว้บางส่วนที ่ไม่สำคัญ เนื ่องจาก
สามารถทำความเข้าใจเองได้อย่างไม่ยากเย็นนัก

ผู้อา่นจะพบได้ว่า ถ้าเริ่มต้นเขียนโปรแกรมในปัจจุบัน โปรแกรมวิชวล
เบสิกเป็นโปรแกรมที่นักเขียนโปรแกรมน่าสนใจ เพราะรูปแบบในการเขียน
ง่ายมาก หนังสือเล่มนี้ จะเหมาะสมกับผู้ที่จะเป็นโปรแกรมเมอร์มือใหม่ หรือ
บุคคลที่ต้องการเริ่มเขียนโปรแกรมอย่างจริงจัง

VB
Visual Basic
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1. จงอธิบายถึงสภาพแวดล้อมของโปรแกรมวิชวลเบสิก

2. จงอธิบายถึงความแตกต่างของแท็บ Existing กับแท็บ Recent

3. จงอธิบายถึงความสำคัญของทูลบาร์

4. จงอธิบายถึงความสำคัญของทูลบล็อก

5. จงอธิบายถึงความสำคัญของฟอร์ม

6. จงอธิบายถึงความสำคัญของหน้าต่าง Project Explerer

7. จงอธิบายถึงความสำคัญของหน้าต่างคุณสมบัติ

8. จงอธบิายถงึความสำคญัของหนา้ตา่ง Form Layout

9. จงอธิบายถึงความแตกต่างของโหมด SDI กับโหมด MDI

10. ถ้าจะทำให้โปรแกรมวิชวลเบสิกอ่านภาษาไทยได้ จะต้องทำอย่างไร

11. จงอธิบายคุณสมบัติ (properties) เมท็อด (method ) และอิเวนต์ (event)

12. ทำไมถึงต้องมีการทดสอบโปรแกรมที่ออกแบบ ก่อนแจกจ่ายไปยังผู้ใช้งาน

 ·∫∫Ω÷°À—¥∑È“¬∫∑ VB
Visual Basic


